Pemetaan Daerah Rawan Kebakaran

Solichin
Laut Tarigan
Paul Kimman
Bona Firman
Radian Bagyono
Pemetaan Daerah Rawan Kebakaran

Solichin
Laut Tarigan
Paul Kimman
Bona Firman
Radian Bagyono

2007

South Sumatra Forest Fire Management Project
Untuk memperoleh buku ini atau informasi lebih lanjut, silahkan hubungi:

**South Sumatra Forest Fire Management Project**
Jl. Jendral Sudirman Km 3,5 No 2837 Palembang 30129
Telp/fax: 0711-377821 / 0711-353 176
ssffmp.eu@telkom.net
http://www.ssffmp.or.id

**Dinas Kehutanan Provinsi Sumatera Selatan**
Jl. Kol. H. Burlian Km 6.5 Punti Kayu Palembang
Telp/fax: 0711-411476 / 411479
http://www.dishutsumsel.go.id

**Balai Pemantapan Kawasan Hutan Wilayah II**
Jl. Kol. H. Burlian Km 6 PO Box 95 Palembang
Telp/fax: 0711-410819 / 418219
bpkh2_plb@yahoo.com
Kata Pengantar

South Sumatra Forest Fire Management Project (SSFFMP) merupakan proyek kerjasama bilateral antara Pemerintah Indonesia dengan Pemerintah Uni Eropa yang bertujuan untuk mengurangi dampak akibat kebakaran hutan dan lahan. Salah satu komponen di dalam proyek SSFFMP adalah Sistem Informasi Kebakaran yang berperan di dalam mendukung dan mengembangkan kapasitas instansi terkait di dalam pengumpulan, pengolahan serta penyebaran informasi terkait dengan kebakaran.

Pengembangan kapasitas atau kemampuan pihak terkait di dalam menjalankan operasi-operasi pengelolaan kebakaran hutan merupakan hal penting yang dilakukan oleh SSFFMP. Selain kegiatan pengembangan organisasi, pelatihan, dan penyediaan alat, penyusunan prosedur operasi atau panduan pelaksanaan juga sangat diperlukan untuk menjamin keberlangsungan kegiatan. Karenanya penyusunan manual ini diharapkan dapat dimanfaatkan bagi instansi terkait di dalam pemantapan kapasitas pengendalian kebakaran hutan dan lahan, khususnya di dalam pengembangan sistem informasi kebakaran.

Diharapkan buku panduan ini dapat bermanfaat bagi pihak terkait serta memberikan kontribusi bagi perbaikan sistem pengendalian kebakaran hutan dan lahan khususnya di Provinsi Sumatera Selatan.

EU Co-Director

Dr. Karl-Heinz Steinmann

National Co-Director

Dr. Dodi Supriadi
Daftar Isi

Kata Pengantar ........................................................................................................ i
Daftar Isi .................................................................................................................. ii

1. Pendahuluan ......................................................................................................... 1
   A. Latar Belakang ................................................................................................. 1
   B. Tujuan ........................................................................................................... 2
   C. Penggunaan Manual ....................................................................................... 2

2. Analisa Penyebab Kebakaran ........................................................................... 3
   A. Pemicu Kebakaran ......................................................................................... 3
   B. Kondisi Pendukung ....................................................................................... 5

3. Metodologi ........................................................................................................... 8
   A. Metode .......................................................................................................... 8
   B. Data yang Diperlukan .................................................................................. 9
   C. Hardware dan Software ............................................................................. 11

4. Penyiapan Data .................................................................................................. 12
   A. Memulai ArcView dan ModelBuilder ......................................................... 12
   B. Konversi Data Penutupan Lahan (Shapefile ke GRID) ............................. 13
   C. Klasifikasi Ulang (Reclass) Data Ketinggian ........................................... 18
   D. Memasukan Data Penyebaran Lahan Gambut ........................................... 24

5. Pembobotan dan Penilaian (Weighting/Scoring) ............................................ 26
   A. Memulai Proses Weighted Overlay ............................................................ 26
   B. Pembobotan dan Penilaian Peta Ketinggian ............................................. 30
   C. Pembobotan dan Penilaian Peta Tanah ..................................................... 31

6. Menyimpan dan Menjalankan Model ............................................................... 37
   A. Menyimpan Project ModelBuilder .................................................................. 37
   B. Menjalankan Model ..................................................................................... 37

7. Hasil dan Pembahasan ....................................................................................... 40

Bahan Bacaan ......................................................................................................... 44

Lampiran .................................................................................................................. 45

1. Sebaran Hotspot Berdasarkan Tutupan Lahan Tahun 2006 ....................... 45
2. Sebaran Hotspot Berdasarkan Jenis Tanah Tahun 2006 ............................. 45
3. Sebaran Hotspot Berdasarkan Ketinggian Tahun 2006 ............................. 46
4. Tabel penyebaran daerah rawan kebakaran di Sumatera Selatan ............ 47
1. Pendahuluan

A. Latar Belakang


Hanya saja, kegiatan perencanaan untuk pencegahan dan pemadaman kebakaran memerlukan informasi yang akurat, aktual serta mudah dipahami oleh pengambil keputusan. Seringkali informasi mengenai daerah rawan kebakaran tidak disajikan secara jelas, serta tidak didasari atas metode pengolahan yang secara metodologi tidak konsisten, sehingga cenderung subyektif dan tergantung dari pengolah data.

Informasi mengenai daerah rawan kebakaran merupakan informasi yang sangat penting dan diperlukan oleh fire manager atau pengambil keputusan di dalam kegiatan pengendalian kebakaran hutan dan lahan. Saat musim kemarau panjang, kebakaran besar bisa terjadi di areal yang luas dan sulit dijangkau. Keterbatasan sumberdaya pemadaman menjadi salah satu kendala yang paling sering dihadapi di lapangan. Karena itu kegiatan pengendalian perlu difokuskan ke wilayah-wilayah yang rawan kebakaran.

Peta daerah rawan kebakaran karenanya berperan penting di dalam membantu fire manager di dalam mengambil keputusan tersebut. Penyajian secara spasial akan lebih membantu memberikan gambaran
Pemetaan Daerah Rawan Kebakaran

yang jelas dan akurat mengenai lokasi, jarak serta aksesibilitas antara lokasi daerah rawan dengan sumber daya pemadaman yang ada di lapangan.

Permasalahan selanjutnya muncul saat peta tersebut tidak akurat lagi, akibat adanya perubahan dari faktor-faktor yang digunakan untuk peta rawan kebakaran tersebut. Sebagai contoh, penutupan lahan cenderung akan cepat berubah sehingga akan memiliki karakteristik yang berbeda terhadap perilaku kebakaran. Untuk itu diperlukan kemampuan bagi operator Sistem Informasi Kebakaran untuk melakukan pemutakhiran (updating) peta sesuai dengan perubahan yang terjadi, sehingga menjadi lebih akurat.

B. Tujuan


C. Penggunaan Manual

2. Analisa Penyebab Kebakaran

A. Pemicu Kebakaran


Penyulutan api oleh manusia juga dikelompokkan menjadi 2 komponen yaitu kesengajaan dan kecerobohan. Walaupun seringkali kebakaran besar diawali dari upaya yang disengaja dan akibat ketidakpahaman pembakar mengenai kondisi yang ada, sehingga menjadi kecerobohan yang menyebabkan kebakaran merambat ke tempat lain.

Motivasi dari pembakaran/kebakaran yang disengaja dan biasa dijumpai di Sumatera Selatan meliputi beberapa hal, antara lain:

1. **Penyiapan lahan** baik oleh perusahaan maupun oleh masyarakat. Ini merupakan kasus terbanyak yang terjadi di Sumatera dan Kalimantan. Sejak berkembangnya budidaya kelapa sawit, kebutuhan akan lahan yang sesuai dan menguntungkan sangatlah tinggi. Seringkali lahan yang ditutupi hutan menjadi incaran bagi investasi tersebut. Tiga hal yang mendasari pemikiran tersebut, yaitu: (1) biasanya lahan berhutan relatif jauh dari masyarakat sehingga memiliki resiko konflik lahan yang rendah, (2) dengan adanya penutupan hutan, unsur hara yang dikandung tanah lapisan atasnya sangatlah subur, dan (3) potensi kayu yang dapat ditebang juga sangat menarik untuk dijadikan keuntungan
Pemetaan Daerah Rawan Kebakaran

tambahan sebelum pemanenan hasil penanaman. Penyiapan lahan oleh masyarakat cenderung lebih bijaksana, terkendali serta berdampak kecil. Selain itu penyiapan lahan dengan membakar dilakukan untuk memenuhi kebutuhan primer masyarakat kecil. Namun, terlepas dari kontroversi penggunaan api oleh masyarakat, ada tiga hal yang perlu disikapi secara tegas, pertama pembakaran di lahan gambut walaupun oleh masyarakat, termasuk sonor, harus dihindari mengingat sulitnya upaya pembakaran terkendali di lahan gambut, kedua pengaturan jadwal pembakaran perlu dilakukan agar tetap berdampak kecil, ketiga perlunya mengantisipasi pembakaran oleh pelaku yang mengatasnamakan masyarakat kecil yang dibayar untuk membakar lahan milik perusahaan atau juragan pemilik lahan. Hal yang demikian juga mulai banyak terjadi.

2. **Pembukaan akses** untuk mencari kayu, ikan ataupun berburu. Di areal hutan gambut yang telah terdegradasi seperti di Padang Sugihan dan Padang Sugihan OKI, pencari kayu mulai mencari kayu tenggelam yang sudah terendam beberapa tahun sebelumnya, baik akibat roboh secara alami ataupun sisa bekas tebangan yang tidak termanfaatkan. Karena berada dalam kondisi anaerob akibat terendam air, maka tidak terjadi pelapukan terhadap kayu tenggelam tersebut. Selain itu, di Kecamatan Bayung Lencir juga banyak dijumpai masyarakat yang memanfaatkan kayu gelam (Melaleuca sp) di lahan gambut sekunder untuk dijual sebagai bahan bangunan. Untuk keperluan membuka akses yang lebih baik, pembakaran dilakukan untuk di lahan-lahan gambut tersebut.

3. **Berburu dan mencari ikan** merupakan aktifitas masyarakat yang masih bisa dijumpai di sekitar kawasan hutan. Penggunaan api sebenarnya tidak secara langsung digunakan untuk berburu, melainkan untuk membakar semak atau rumput sehingga memungkinkan munculnya tunas-tunas atau rumput muda yang disukai oleh hewan-hewan
Pemetaan Daerah Rawan Kebakaran

...ungulata, seperti rusa dan kijang. Beberapa literatur menyatakan bahwa pembakaran semak di sekitar rawa juga dilakukan oleh pencari ikan, dan diperkirakan juga untuk menarik perhatian ikan akibat abu hasil pembakaran. Namun, di wilayah pesisir Sumatera Selatan, sebagian besar pencari ikan melakukan pembakaran semak agar lebih memudahkan menemukan ceruk-ceruk tempat ikan berkumpul di musim kemarau.


B. Kondisi Pendukung

Perubahan Tutupan Lahan
Perubahan tapak yang dimaksud meliputi perubahan tutupan lahan dan perubahan hodrologi khususnya di lahan gambut. Indonesia yang dulunya sebagian besar merupakan hutan hujan tropis primer menjadi hutan bekas tebangan atau terdegradasi akibat pengusahaan hutan dan exploitasi kayu secara besar-besaran sejak awal tahun 70an. Hilangnya tajuk atau kanopi pohon besar menyebabkan kondisi hutan menjadi lebih terbuka terhadap sinar matahari dan iklim mikro menjadi lebih kering. Limbah bekas tebangan juga seringkali menjadi bahan bakar yang sangat potensial meningkatkan intensitas kebakaran. Di hutan yang terdegradasi menjadi semak belukar, bahkan menjadi lebih rawan lagi terhadap kebakaran, karena mudahnya penyulutan dan penyebaran api.

Perubahan Hidrologi
Perubahan hidrologi khususnya di lahan gambut juga merupakan kondisi yang sangat mendukung terjadinya kebakaran. Akibat terbatasnya lahan untuk pertanian, perkebunan dan hutan tanaman, banyak lahan gambut dalam yang dikeringkan (drained) dengan membuat kanal-kanal yang membelah kubah gambut. Selain mengeringkan lahan gambut, kanal juga berfungsi sebagai aksesibilitas bagi masyarakat untuk masuk ke lebih jauh ke dalam areal lahan gambut untuk melakukan aktifitas yang seringkali juga menimbulkan kebakaran.

Pengaruh Sosial Ekonomi dan Budaya
Sebagai salah satu faktor utama di dalam penyebab kebakaran, perilaku manusia sangat dipengaruhi oleh kondisi sosial ekonomi serta budaya. Faktor kemiskinan sering diusung sebagai faktor utama yang mengarahkan perilaku membakar hutan. Karenanya banyak pendekatan pencegahan kebakaran dilakukan melalui pemberdayaan masyarakat sekitar hutan. Namun demikian, budaya penggunaan api sebenarnya juga sudah lama diterapkan oleh banyak masyarakat tradisional yang hidup di sekitar hutan.
atau peladang berpindah. Bahkan hukum dan aturan adat juga telah dibuat sehingga pembakaran yang mereka lakukan memiliki dampak yang kecil terhadap masyarakat dan lingkungan.

Di banyak tempat di Sumatra dan Kalimantan, dimana lahan pertanian menjadi lebih terbatas, masyarakat baik lokal maupun pendatang juga mulai merambah areal lahan gambut, baik untuk mencari kayu, berburu, mencari ikan dan bahkan pertanian. Pertanian di lahan gambut bukanlah tradisi dan budaya masyarakat tradisional di Sumatra dan Kalimantan. Karena itu upaya pencegahan dan penyadaran akan bahaya kebakaran hutan dan lahan perlu difokuskan di wilayah ini.

Selain itu budaya pemahaman dampak asap juga masih sangat rendah. Masyarakat seringkali tidak peduli dengan dampak pembakaran yang mereka lakukan terhadap masyarakat sekitar dan lingkungan. Contoh kecil yang sering kita lihat adalah, masih banyaknya masyarakat di kota yang masih membakar sampahnya, apalagi masyarakat di daerah pedesaan yang tidak memiliki akses dan teknologi untuk membersihkan lahan secara mekanis. Akibatnya, undang-undang dan peraturan yang melarang masyarakat melakukan pembakaran, mendapat resistensi di dalam penerapannya.
3. Metodologi

Tidak ada teknologi lain kecuali GIS (Geographic Information System) yang mampu melakukan visualisasi secara efektif mengenai kondisi geografis yang akurat, kejadian bencana kebakaran, ataupun perkiraan ancaman kebakaran yang akan terjadi. Informasi spasial tersebut akan sangat membantu fire manager di dalam melakukan identifikasi dan perencanaan, pencegahan, persiapan, respon serta restorasi (Greene, 2002).

A. Metode

Peta rawan kebakaran merupakan model spasial yang digunakan untuk merepresentasikan kondisi di lapangan terkait dengan resiko terjadinya kebakaran hutan dan lahan. Model ini dibuat menggunakan aplikasi GIS untuk memudahkan proses overlay antar faktor-faktor penyebab kebakaran. Karenanya, memahami faktor-faktor penyebab dan perilaku kebakaran merupakan hal yang sangat utama di dalam melakukan permodelan ini.

Mengingat keterbatasan data yang ada, pendekatan dilakukan dengan menerapkan beberapa asumsi untuk melengkapi keterwakilan data. Model peta rawan kebakaran ini tidak secara khusus memperhatikan potensi penyulutan, melainkan lebih secara luas memprediksi kemungkinan kebakaran akan terjadi serta kemungkinan intensitas serta dampak yang ditimbulkan. Potensi penyulutan juga dikembangkan sebagai salah satu komponen di dalam Sistem Analisa Ancaman Kebakaran (Ruecker, 2007) yang dikembangkan oleh SSFFMP.

\[
\text{Rawan Kebakaran} = (0.4 \times \text{[Penutupan Lahan]}) + (0.3 \times \text{[Lahan Gambut]}) + (0.3 \times \text{[Zona Iklim/Elevasi]})
\]
Penilaian (scoring) dilakukan dengan menggunakan hasil analisa dari penyebaran hotspot selama musim kemarau panjang, yang lebih menarik dan relevan bagi fire manager untuk bahan pertimbangan musim kebakaran selanjutnya. Hasil analisa frekuensi hotspot dari berbagai faktor tersebut selanjutnya di klasifikasi ke dalam beberapa kelas nilai (misalnya 1-5). Sedangkpn pembobotan (weighting) dilakukan dengan menggunakan penilaian berdasarkan pengetahuan serta kondisi yang terjadi di lapangan (expert judgement). Faktor dengan pengaruh lebih besar mendapatkan pembobotan yang lebih besar dibandingkan faktor lainnya. Dalam hal ini pengaruh penutupan lahan dianggap lebih besar dibanding faktor lainnya, mengingat selain terkait dengan data vegetasi, penutupan lahan juga terkait dengan penggunaan lahan, seperti pertanian, perkebunan, HTI, dll.

B. Data yang Diperlukan

Data – data tematik yang diperlukan hanya terdiri dari 3 jenis data yang relatif mudah untuk didapatkan. Yaitu peta penutupan lahan, penyebaran gambut serta ketinggian. Data-data tersebut harus dalam format GIS serta memiliki sistem koordinat dan proyeksi yang sama.

Penutupan Lahan yang diperoleh dari hasil interpretasi citra satelit yang dilakukan oleh BPKH II, digunakan sebagai salah satu faktor yang terkait dengan penggunaan lahan aktual. Wilayah yang terdegradasi dan tidak memiliki pola pemanfaatan intensif cenderung rawan terhadap kebakaran.

Lahan Gambut merupakan faktor penting yang berpengaruh terhadap intensitas dan dampak kebakaran yang terjadi. Kebakaran lahan gambut sangat sulit dipadamkan dan menyebabkan polusi kabut asap. Selain itu dampak emisi karbon akibat kebakaran lahan gambut juga berpotensi terhadap peningkatan gas rumah kaca.
Informasi penyebaran lahan gambut diperoleh dari peta unit lahan yang dikeluarkan oleh Puslitanak.

**Elevasi atau ketinggian** diperoleh dari data Digital Elevation Model (DEM) SRTM. Informasi ketinggian digunakan untuk membedakan dataran rendah (0-25) daerah lahan kering (25 -1000 m) dan dataran tinggi atau pegunungan (1000 – 3000 m). Pembagian tiga zona ketinggian ini terkait dengan pembagian zona iklim, mengingat curah hujan di Sumatera dipengaruhi oleh topografi yang berkisar antara 6000 mm per tahun di wilayah barat atau sekitar bukit Barisan hingga 1500 mm di bagian timur (Whitten *et al*, 2000).

Seperti terlihat pada peta di atas yang merupakan peta pembagian zona iklim di Sumatera, untuk Provinsi Sumatera Selatan terdapat 3 zona iklim (Whitten *et al*, 2000).

**Batas Provinsi** atau batas lainnya digunakan hanya sebagai batas areal yang akan dianalisa, sehingga peta yang dihasilkan memiliki areal sesuai
dengan yang kita inginkan. Format batas tersebut harus dalam bentuk ESRI GRID. Dalam hal ini digunakan batas Provinsi Sumsel.

C. Hardware dan Software

ArcView 3.x dan ArcView Spatial Analyst diperlukan untuk penyusunan peta rawan kebakaran ini. Untuk menjalankan program ArcView 3.3 dan Spatial Analyst dalam platform PC-Intel, paling tidak diperlukan komputer yang memiliki sistem operasi Windows 2000 atau yang terbaru (kecuali Windows Vista). Sehingga persyaratan minimal PC yang diperlukan antara lain: Memory / RAM sebesar 64 MB serta free disk space sekitar 300 MB.
4. Penyiapan Data

Sebelum memulai, pastikan persyaratan yang diperlukan untuk melakukan analisa ini terpenuhi. Semua data yang digunakan dalam penjelasan ini dapat diperoleh di dalam CD yang menyertai manual.

A. Memulai ArcView dan ModelBuilder

1. Start ArcView

Atur properties melalui menu **View > Properties**:

![Map Unit: Meter, Distance Unit: Kilometer]

3. Klik OK

4. Aktifkan extension yang diperlukan: **File > Extension** > beri tanda check pada **ModelBuilder** dan **Spatial Analyst**.
5. Klik **OK**

6. Masukan data ke dalam tampilan View. Contoh data dapat diperoleh di CD yang disertakan dalam manual ini:

   - Penutupan lahan atau vegetasi dalam format shapefile (**landcover.shp**).
   - Elevasi atau data ketinggian dalam format GRID yang diperoleh dari data SRTM (**elevasi**).
   - Data penyebaran gambut yang diperoleh dari peta Land Unit Puslitanaak dalam format GRID (**tanah**).
   - Batas Provinsi Sumsel sebagai batas areal yang ingin dianalisa dalam format GRID (**sumsel**)

8. Mulai **ModelBuilder** dengan mengklik menu **Model > Start ModelBuilder**

   Selanjutnya, jendela ModelBuilder akan muncul.

### B. Konversi Data Penutupan Lahan (Shapefile ke GRID)

Untuk pengolahan data menggunakan Spatial Analyst, diperlukan data dengan format GRID ESRI. Kecuali data elevasi dan tanah, landcover masih dalam format shapefile.

1. Klik menu **Add Process > Data Coversion > Vector to Grid**

2. Di jendela **Vector Conversion** yang muncul, klik **Next**
3. Pilih shapefile apa yang akan di konversi

Choose the input theme: Landcover
Choose the input field: Kelas_new
Lalu klik Next.
4. Klik **Next** pada jendela yang muncul.

5. Klik **Next** pada jendela yang muncul.
6. Tentukan layar yang akan digunakan sebagai batas analisis.

The extent of this theme: Sumsel

Lalu klik Next

7. Tentukan cell size, atau resolusi rasternya.

The cell size of this theme: Sumsel

Lalu klik Next.
8. Beri nama untuk peta dan file penutupan lahan yang akan dibuat.

Enter the theme name: Peta Landcover
Enter the file name: lc_grd

Lalu klik OK.

Hal yang perlu diperhatikan untuk penamaan file atau folder terkait dengan data format GRID, adalah harus sesuai dengan kaidah penamaan DOS, dimana hanya terbatas sebanyak 8 karakter dan tanpa spasi.

Setelah proses diatas selesai dilakukan, maka pada halaman ModelBuilder akan muncul Flowchart / bagan alur tentang proses konversi yang kita lakukan yaitu konversi data landcover dalam format shapefile berdasarkan kolom “Nama_Kelas” menjadi “Peta landcover” dalam format GRID.
Pengklasifikasian ulang data ketinggian dilakukan untuk mendapatkan layer sebaran kelas ketinggian yang terkait dengan perbedaan zonasi iklim. Untuk wilayah Sumatera Selatan, zonasi iklim dikategorikan ke dalam 3 zona, yaitu zona dataran rendah (0 - 25 m), lahan kering (25 - 500 m) dan pegunungan (500 – 3000 m).

1. Klik **Add Process > Reclassification**

Lalu klik **Next**

2. Pilih data ketinggian yang akan diklasifikasi ulang (**reclass**)

Choose the input theme: **Ketinggian**
3. Tentukan kolom input yang akan digunakan untuk proses analisa.

![Image of reclassification window] Choose the input field: **Value**

Lalu klik **Next**.

4. Tentukan jenis metode klasifikasi yang diinginkan.
Selanjutnya klik **Next**, maka akan muncul jendela di bawah ini:

Secara *default* akan muncul klasifikasi ketinggian seperti yang diatas. Mengingat kita hanya membutuhkan 3 kelas ketinggian, maka kita harus menghapus kelas-kelas yang tidak kita butuhkan, dan mengeditnya sebagian.
5. Klik pada ujung baris yang akan dihapus sampai baris yang dipilih akan terblok warna biru, lalu klik tombol *Delete Class*

Demikian seterusnya, hingga jumlah baris kelas yang ada menjadi 3 kelas ketinggian saja.

6. Isikan nilai pada kolom *Class Start Value* dan *Class End Value* sesuai nilai pada gambar dibawah ini:

Selanjutnya klik *Next*. 
7. Tentukan batas analisis, dengan memilih batas sumsel.

The extend of this theme: Sumsel

8. Tentukan tingkat resolusi yang diinginkan (sesuai dengan resolusi data Sumsel).

The cell size of this theme: Sumsel
9. Beri nama layer (theme name) dan nama file (file name) sesuai dengan gambar dibawah:

![Screenshot of Reclassification process]

Perhatikan kembali kaidah penamaan file (file name) GRID, yang dibatasi hanya 8 karakter dan tanpa spasi.

9. Selanjutnya klik **Finish**.

Sebuah bagan alur yang menggambarkan proses “Reclass” dari data “Elevasi” menjadi sebuah “Peta Ketinggian”, akan muncul dan menambahkan dari bagan alur yang sebelumnya dibuat.

```
Elevasi Value -> Reclass -> Peta Ketinggian
```

```
Landcover Nama_kelas -> Vector Conversion -> Peta Landcover
```
Pemetaan Daerah Rawan Kebakaran

Proses tersebut membuat sebuah layer baru yang diberi nama “Peta Ketinggian” yang hanya memiliki 3 kelas ketinggian dan mewakili 3 zona iklim di Sumatera Selatan.

D. Memasukan Data Penyebaran Lahan Gambut

Lahan gambut merupakan salah satu faktor penting terjadinya kebakaran besar yang mengakibatkan kabut asap di Sumatera Selatan. Untuk itu, penyebaran lahan gambut sangat penting untuk dimasukkan ke dalam model daerah rawan kebakaran ini. Data gambut diperoleh dari data jenis tanah yang diperoleh dari Puslitanan Bogor. Dalam hal ini, data tanah sudah dalam format GRID.

1. Klik tombol Add data (tombol dengan logo kotak biru)
2. Arahkan mouse ke bagian kosong di View project yang kita kerjakan saat ini (misalnya di bagian atas flow chart yang sudah ada, lalu Klik kiri, maka akan muncul kotak kosong pada halaman ModelBuilder dengan nama Data.
3. Arahkan mouse ke kotak “Data” tersebut, lalu **Klik kanan**, dan pilih **Theme**.

4. Klik kanan pada kotak “Theme” yang baru, lalu pilih **Properties**.

5. Tentukan data yang ingin digunakan sebagai data penyebaran lahan gambut.
5. Pembobotan dan Penilaian (Weighting/Scoring)

Setelah semua data lengkap, selanjutnya dilakukan proses pembobotan dan penilaian terhadap masing-masing faktor dan parameternya. Proses dilakukan menggunakan metode Weighted Overlay, dimana selain kita memberi nilai dari tiap parameter yang ada, kita juga dapat memberi bobot dari pengaruh suatu faktor terhadap tingkat kerawanan kebakaran.

\[
\text{Rawan Kebakaran} = (0.4 \times \text{Penutupan Lahan}) + (0.3 \times \text{Lahan Gambut}) + (0.3 \times \text{Zona Iklim/Elevasi})
\]

Untuk itu kita perlu memberikan nilai dan bobot dari ketiga faktor yang sebelumnya telah kita masukkan. Sesuai dengan rumus diatas, maka nilai bobot yang diterapkan adalah:

1. Peta Landcover (40%)
2. Peta Ketinggian (30%)
3. Peta Tanah (30%)

A. Memulai Proses Weighted Overlay

1. Klik menu \textit{Add Process} \rightarrow \textit{Overlay} \rightarrow \textit{Weighted Overlay}
Lalu klik Next.

2. Pilih Skala Evaluasi (Evaluation Scale) yang ingin digunakan.

Choose a predefined evaluation scale: 1 to 5

Lalu klik Next. Maka akan muncul jendela Weighted Overlay yang masih kosong.
Pembobotan dan Penilaian Peta Landcover

1. Klik tombol *Add Theme*
Masukan paramater pertama yaitu *Peta Landcover*

   ![Image of Add Theme](image.png)

   *Choose the input theme*: Peta Landcover  
   *Choose the input field*: Value

2. Klik *OK*

   Pada jendela yang muncul, perhatikan 2 kolom yang harus diisi dengan nilai yang sesuai, yaitu kolom “% Inf” atau % of influence yang merupakan nilai untuk pembobotan dari sebuah faktor atau layer, serta “Scale Value” yang merupakan nilai tiap unsur dari faktor tertentu.

3. Untuk merubah nilai pada kolom “% Inf”, klik sel kosong di bawahnya, lalu ketik angka 40. Untuk merubah nilai “Scale Value”, klik di sel yang ingin dirubah, lalu pilih nilai dari daftar nilai yang ada (*drop down list*) yang berkisar antara 1-5 dan *restricted*.

<table>
<thead>
<tr>
<th>Input Theme</th>
<th>% Inf</th>
<th>Input Field</th>
<th>Input Label</th>
<th>Scale Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peta Landcover</td>
<td>40</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Air</td>
<td>Restricted</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Awan</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Belukar</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Belukar Rawa</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Hutan Mangrove Prim</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Hutan Mangrove Sekunder</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Hutan Primer</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Hutan Rawa Primer</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>Hutan Rawa Sekunder</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>Hutan Sekunder</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>Hutan Tanaman/Lahan G+</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>Hutan Tanaman/Lahan Ke</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>Pemukiman</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>Perkebunan</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>PerkebunanKaret</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>PerkebunanSawit</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>PerkebunanSawit/Karet</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>PerkebunanTebu</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>Pertanian Campuran</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>Pertanian Lahan Keri</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>Rawa</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>Sawah</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>Semak Rawa</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>Tanah</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>Tambang</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td>Tanah Terbuka</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td>Transmigrasi</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>NODATA</td>
<td>No Data</td>
<td>Restricted</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
B. Pembobotan dan Penilaian Peta Ketinggian


1. Dari jendela Weighted Overlay, Klik **Add theme**

   ![Weighted Overlay](image1)

   - **Choose the input theme**: Peta Ketinggian
   - **Choose the input field**: Value

2. Pilih nama layer Peta Ketinggian yang ingin dimasukkan.
Lalu klik OK.

<table>
<thead>
<tr>
<th>Input Theme</th>
<th>% Inf</th>
<th>Input Field</th>
<th>Input Label</th>
<th>Scale Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peta Ketinggian</td>
<td>30</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0 - 25</td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>25 - 500</td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>500 - 3200</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>NODATA</td>
<td>No Data</td>
<td></td>
<td>Restricted</td>
<td></td>
</tr>
</tbody>
</table>

Tentukan nilai % Inf sesuai dengan nilai bobot masing-masing layer pada rumus yang telah dijelaskan sebelumnya. Dalam hal ini ketik angka 30 untuk memberi bobot sebesar 30% bagi Peta Ketinggian atau Zonasi Iklim. Selanjutnya rubah nilai “Scale Value” dari masing-masing nilai seperti gambar di atas.

C. Pemobotan dan Penilaian Peta Tanah

Selanjutnya kita akan menambahkan Peta Ketinggian ke dalam Weighted Overlay.

1. Klik **Add theme** dari jendela Weighted Overlay.

2. Pilih layer **Tanah** dan kolom **Status**.
Lalu klik OK.

3. Tentukan nilai % Inf sesuai dengan nilai bobot masing-masing layer pada rumus yang telah dijelaskan sebelumnya. Dalam hal ini ketik angka 30 untuk memberi bobot sebesar 30% bagi Peta Tanah atau Penyebaran Gambut. Selanjutnya rubah nilai "Scale Value" dari masing-masing nilai seperti gambar di bawah.

<table>
<thead>
<tr>
<th>Input Theme</th>
<th>% Inf</th>
<th>Input Field</th>
<th>Input Label</th>
<th>Scale Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tanah</td>
<td>30</td>
<td>non_peat</td>
<td>non_peat</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>peat</td>
<td>peat</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOD&amp;TA</td>
<td>No Data</td>
<td>1</td>
</tr>
</tbody>
</table>

Saat ini kita telah memasukkan 3 layer untuk digunakan dalam proses *Weighted Overlay*, yaitu Peta Landcover, Peta Ketinggian, serta Peta Tanah atau penyebaran gambut. Selain memberi bobot, kita juga telah memberi nilai dari masing-masing kelas dari layer-layer tersebut, seperti pada gambar berikut.
Pemetaan Daerah Rawan Kebakaran

4. Selanjutnya, Klik **OK**
5. Pilih salah satu gradasi warna yang akan digunakan untuk peta keluaran. Lalu klik Next.

6. Pilih batasan areal yang akan dianalisa.

The extent of this theme: Sumsel
7. Tentukan resolusi yang diinginkan. Pilih layer **Sumsel**. Lalu klik **Next**

8. Beri nama peta (Peta Rawan Kebakaran) dan nama file output (FDR_grd). Lalu klik **Finish**.
Sebuah model Peta Rawan Kebakaran yang lengkap telah disusun dan siap dijalankan. Namun sebelumnya kita dapat mengklik kedua tombol di bawah ini untuk merapihkan diagram alur yang kita susun.
6. Menyimpan dan Menjalankan Model

A. Menyimpan Project ModelBuilder

Project yang telah disusun bisa disimpan ke dalam hard disk, sehingga bisa dibuka kembali kapan pun untuk melakukan pembaharuan atau updating peta.

1. Klik *File > Save As*

2. Masukan lokasi harddrive tempat data permodelan akan disimpan

   *Drives*: tentukan drive  
   *Save In*: tentukan foldernya  
   *Model name*: *firerisk* atau *petarawan*

B. Menjalankan Model

Setelah semua prosedur dijalankan dan model sudah lengkap, langkah selanjutnya adalah menjalankan model secara keseluruhan. Pastikan seluruh komponen dalam bagan alur memiliki warna, yang berarti tidak ada kesalahan dari input data.
1. Klik menu **Model > Run Entire Model** secara otomatis ArcView akan menjalankan proses penyusunan peta rawan kebakaran berdasarkan model yang telah disusun sebelumnya. Biasanya diperlukan waktu beberapa menit tergantung dari spesifikasi komputer yang digunakan. Jika proses berhasil, maka akan tampil sebuah layer peta rawan kebakaran baru.

2. Untuk memudahkan klasifikasi kelas di dalam tampilan peta, ubah legenda peta dengan merubah warna dan label dari nilai-nilai layer tersebut seperti tabel di berikut ini.
Pemetaan Daerah Rawan Kebakaran

<table>
<thead>
<tr>
<th>Nilai</th>
<th>Label</th>
<th>Warna</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tidak Rawan</td>
<td>Hijau</td>
</tr>
<tr>
<td>2</td>
<td>Rendah</td>
<td>Kuning</td>
</tr>
<tr>
<td>3</td>
<td>Sedang</td>
<td>Jingga</td>
</tr>
<tr>
<td>4</td>
<td>Tinggi</td>
<td>Merah</td>
</tr>
<tr>
<td>5</td>
<td>Sangat Rawan</td>
<td>Merah Tua / Coklat</td>
</tr>
</tbody>
</table>

Selanjutnya, tampilan peta rawan yang dibuat akan seperti pada gambar di atas. Secara visual, tingkat kerawanan kebakaran ditampilkan dengan warna hijau, kuning, jingga, merah dan coklat untuk mewakili tingkat rawan kebakaran mulai dari tidak rawan, rendah, sedang, tinggi dan sangat rawan. Sehingga lebih memudahkan interpretasi peta oleh pengguna akhir.
7. Hasil dan Pembahasan


Grafik penyebaran daerah rawan kebakaran per kabupaten di Sumatera Selatan.

Kabupaten OKI memiliki daerah sangat rawan kebakaran yang sangat luas, lebih dari 470 ribu hektar. Hal ini akibat cukup luasnya areal lahan...

Rendahnya aksesibilitas yang dapat dilalui oleh regu-regu pemadam juga menyulitkan upaya pemadaman oleh regu Manggala Agni. Ditambah lagi dengan terbatasnya sumber air di lahan gambut saat kemarau, mengakibatkan regu pemadam hanya mampu menjangkau areal lahan gambut tidak lebih dari 500 meter dari di pinggir jalan dan kanal. Alternatif transportasi bagi regu pemadam, selain akses jalan, karenanya sangat perlu diperhatikan, mengingat sulitnya aksesibilitas menuju areal lahan gambut yang terdegradasi. Namun, upaya pencegahan perlu diprioritaskan di wilayah ini.

Tidak semua areal dataran rendah di wilayah pesisir timur Sumatera Selatan berada dalam tingkat rawan kebakaran yang tinggi. Taman Nasional Sembilang (TNS) sebagian besar masih berada dalam tingkat rawan sang rendah. Hal ini karena wilayah TNS masih didominasi oleh hutan bakau (mangrove) yang masih

Sementara itu, Kabupaten Lahat, Muara Enim, Musi Rawas serta OKU Selatan memiliki daerah yang tidak rawan kebakaran yang masih cukup

Daerah dengan tingkat rawan tinggi juga terdapat di OKU Timur. Hal ini disebabkan banyaknya hotspot yang terdeteksi akibat pembakaran di lahan persawahan di kecamatan Belitang yang merupakan lahan pertanian. Seperti halnya pertanian intensif lainnya hal ini tidak memiliki dampak yang cukup besar, mengingat bukan di lahan gambut.

Evaluasi peta rawan kebakaran juga dilakukan untuk mengetahui kualitas informasi terkait dengan penyebaran hotspot. Dengan menggunakan peta rawan kebakaran yang disusun menggunakan hasil analisa penyebaran hotspot tahun 2004, evaluasi dilakukan untuk mengetahui tingkat keakurasian prediksi penyebaran hotspot tahun 2006. Sebagian besar hotspot (hampir 90%) berada di daerah dengan tingkat rawan kebakaran sangat tinggi.

Korelasi yang tinggi antara peta rawan kebakaran dengan penyebaran hotspot pada musim kemarau berikutnya, dapat dilihat dari grafik di atas,
dimana sebaliknya di areal dengan tingkat rawan yang rendah dan tidak rawan, kerapatan penyebaran hotspot sangatlah rendah.

Grafik evaluasi penyebaran hotspot tahun 2006 dengan peta rawan kebakaran yang dibuat tahun 2005.

Karenanya peta rawan kebakaran tersebut dapat digunakan untuk keperluan identifikasi areal prioritas dan perencanaan kegiatan pencegahan, alokasi sumberdaya pemadaman ataupun perencanaan kebijakan dan strategis lainnya. Selain itu, bagi fire manager yang sudah lebih mumpuni (advanced), Sistem Analisa Ancaman Kebakaran merupakan informasi tambahan yang sangat detail dan bermanfaat untuk keperluan perencanaan pada skala yang lebih rinci.

Kehidupan nyata selalu dinamis dan mengalami perubahan. Berbeda dengan peta atau model yang dibuat, hanya mewakili suatu kondisi dalam waktu tertentu. Untuk itu perlu dilakukan pembaharuan data dan peta secara reguler, sehingga akurasi dan aktualitas menjadi lebih baik.
Bahan Bacaan


Lampiran.
3. Sebaran Hotspot Berdasarkan Ketinggian Tahun 2006

Frekuensi Sebaran Hotspot Tahun 2006 Berdasarkan Kelas Ketinggian

<table>
<thead>
<tr>
<th>Kelas Ketinggian</th>
<th>Frekuensi</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 25 m</td>
<td>3.153</td>
</tr>
<tr>
<td>25 - 50 m</td>
<td>1.048</td>
</tr>
<tr>
<td>50 - 100 m</td>
<td>1.337</td>
</tr>
<tr>
<td>100 - 200 m</td>
<td>1.558</td>
</tr>
<tr>
<td>200 - 500 m</td>
<td>0.269</td>
</tr>
<tr>
<td>500 - 1000 m</td>
<td>0.077</td>
</tr>
<tr>
<td>1000 - 2000 m</td>
<td>0</td>
</tr>
<tr>
<td>2000 - 3200 m</td>
<td>0</td>
</tr>
</tbody>
</table>
## Tabel penyebaran daerah rawan kebakaran di Sumatera Selatan

<table>
<thead>
<tr>
<th>Kabupaten</th>
<th>Tidak Rawan</th>
<th>Rendah</th>
<th>Sedang</th>
<th>Tinggi</th>
<th>Sangat Rawan</th>
<th>Total Luas Kabupaten</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ha</td>
<td>%</td>
<td>Ha</td>
<td>%</td>
<td>Ha</td>
<td>%</td>
</tr>
<tr>
<td>Musi Banyuasin</td>
<td>0</td>
<td>0.0</td>
<td>772138</td>
<td>53.0</td>
<td>348678</td>
<td>23.9</td>
</tr>
<tr>
<td>Banyuasin</td>
<td>222</td>
<td>0.0</td>
<td>301731</td>
<td>25.1</td>
<td>362395</td>
<td>30.2</td>
</tr>
<tr>
<td>OKI</td>
<td>4</td>
<td>0.0</td>
<td>329110</td>
<td>18.9</td>
<td>267951</td>
<td>15.4</td>
</tr>
<tr>
<td>Lahat</td>
<td>349185</td>
<td>52.9</td>
<td>218355</td>
<td>33.1</td>
<td>38487</td>
<td>5.8</td>
</tr>
<tr>
<td>Lubuk Linggau</td>
<td>7971</td>
<td>19.0</td>
<td>30998</td>
<td>71.8</td>
<td>1349</td>
<td>3.2</td>
</tr>
<tr>
<td>Muara Enim</td>
<td>108844</td>
<td>12.7</td>
<td>463361</td>
<td>54.0</td>
<td>138710</td>
<td>16.2</td>
</tr>
<tr>
<td>Musi Rawas</td>
<td>251708</td>
<td>20.6</td>
<td>674964</td>
<td>55.2</td>
<td>192136</td>
<td>15.7</td>
</tr>
<tr>
<td>Ogan Ilir</td>
<td>0</td>
<td>0.0</td>
<td>79132</td>
<td>33.3</td>
<td>79585</td>
<td>33.4</td>
</tr>
<tr>
<td>OKU</td>
<td>63702</td>
<td>22.0</td>
<td>133823</td>
<td>46.2</td>
<td>71374</td>
<td>24.7</td>
</tr>
<tr>
<td>OKU Selatan</td>
<td>181321</td>
<td>34.2</td>
<td>188337</td>
<td>35.5</td>
<td>106439</td>
<td>20.1</td>
</tr>
<tr>
<td>OKU Timur</td>
<td>0</td>
<td>0.0</td>
<td>145725</td>
<td>45.2</td>
<td>56193</td>
<td>17.4</td>
</tr>
<tr>
<td>Pagar Alam</td>
<td>56969</td>
<td>94.7</td>
<td>2357</td>
<td>3.9</td>
<td>0</td>
<td>0.0</td>
</tr>
<tr>
<td>Palembang</td>
<td>0</td>
<td>0.0</td>
<td>19846</td>
<td>52.3</td>
<td>15207</td>
<td>40.0</td>
</tr>
<tr>
<td>Prabumulih</td>
<td>0</td>
<td>0.0</td>
<td>36952</td>
<td>87.1</td>
<td>3396</td>
<td>8.0</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>1019926</td>
<td>3395928</td>
<td>1681900</td>
<td>1783467</td>
<td>637652</td>
<td>8706242</td>
</tr>
</tbody>
</table>